
A GIS based Analysis for Rooftop Rain 
Water Harvesting 

Garima Dadhich1 
Garimadadhich29@gmail.com 

Pratishtha Mathur2, 
Department of Computer Science, BanasthaliVidyapith, Jaipur, India 

mathurprati@yahoo.com 

ABSTRACT- For properly Digitizing the Roof area of any building, some parameters need to be 
determined in order to get maximum benefit. Google Earth is used to determine the view or the area with 
proper resolution. The resolution should not be too high to cover the building which have small area and 
should not be too low to cover large building. The QGIS tool is used to convert raster file into vector file 
for calculating the area. Then the amount of rainwater and the Tank capacity is calculated to collect the 
water. 

This paper concerns with computation of the required Roof area for collecting the Rainwater with a 
minimum or maximum average rainfall of the particular area and a Rooftop coefficient. The digitization 
has been done in QGIS for calculating area of different buildings with different parameters and a 
comparative analysis of collected Rainwater from Roofs and also provides the necessary parametric 
specifications to make Decision support system and to setup the Rooftop Rainwater Harvesting plant. 

KEYWORDS: Rooftop Rainwater Harvesting, GIS, Google Earth, QGIS, Average Rainfall, Tank capacity. 

I. INTRODUCTION 

Rainwater harvesting(RWH) is a process involving collection and storage of rain water (with the help of 
artificially designed system) that runs off natural or man-made catchment areas e.g. roof top, compounds, rock 
surface or hill slopes or artificially repaired impervious/semi-pervious land surface. Rainwater harvesting is 
popular all across the world, although in countries that are very dry, such as Australia, it is even more popular. 
Water is our most precious natural resource and something that most of us take for granted. Rainwater 
harvesting will make an important contribution to resolving water shortages in the future. 

Methods of RWH 

To harvest the rainwater, there are two ways broadly: 

1. Surface runoff harvesting. 

2. Roof top rainwater harvesting (RRWH). 

Rooftop rainwater harvesting is the technique through which rain water is captured from the roof catchments 
and stored in reservoirs. Harvested rain water can be stored in sub-surface ground water reservoir by adopting 
artificial recharge techniques to meet the household needs through storage in tanks. Rainwater is allowed to get 
collected in built-up tanks. This water can be used for direct consumption as also for recharging groundwater 
through simple filtration devices. This method is usually employed in the desert areas of Rajasthan which often 
face drinking water problem. 

Need for Rooftop Rain Water Harvesting: 

 to meet the ever increasing demand for water 

 to reduce the runoff which chokes storm drains 

 to avoid flooding of roads 
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Components of rooftop rainwater harvesting 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure1. Components of RRWH 

Fig.1shows the common components of a rainwater harvesting system are catchments, coarse mesh, gutters, 
conduits, first-flushing, filters, storage, recharge structure. 

This paper is divided into six sections. In the first section the introduction about the RRWH has been 
described. The second section presents the related work. The third section discusses the technologies used in the 
experimental study. The fourth section depicts the methodology of Proposed Model. The fifth section describes 
the procedure of acquiring the required information in Case Study. The sixth section presents the future scope 
and the last section draws the conclusion. The Objectiveof this paper which is named as “A GIS based analysis 
for Rooftop Rainwater Harvesting” is preprocessing of data and Analysation of proposed model, Proper 
digitization has been done for calculating the area of roofs and total amount of water of the selected area with 
the help of QGIS tool and a comparative analysis between three areas weather the selected area for water 
collection is appropriate or not. 

II. RELATED WORK 
A lot of work has been done related to Rooftop Rainwater Harvesting in GIS using Google Earth. But both 

the technologies have not been used together much i.e. developing a decision support system for Rooftop 
Rainwater Harvesting using QGIS Tool and Google Earth. There are a number of sources that can help to study 
and work with QGIS Tool. Many sites are available which provide the complete introduction of QGIS and its 
working with starters and also can serve as a useful guide for making maps, joining different maps, modifying 
maps as needed. 

Many papers have been published using the features and Application of ARC GIS and Google Earth. 

 Rooftop Rainwater Harvesting studies in other Countries 
Malan (2014) et al. [2], the study assessed the practice of RWH in a rural community in Edo state, Nigeria. 

Using a cross sectional study design, pre-tested structured interviewer administered questionnaire were 
administered to 232 selected and consenting households. Water was collected from 15% of houses and 
tested for bacteriological quality. Data was analyzed using statistical package for social sciences (SPSS) 
version16. 

 Rooftop Rainwater Harvesting studies in India 
Namrata (2004) et al. [3], defines the better way to collect water as a source for numerous domestic 

applications like drinking, bathing, laundry, toilet flushing, hot water supply and for gardening purposes 
from different areas like Dry Areas, Bad Taste water areas. 

 Research Approaches for Rooftop Rainwater Harvesting: 

Geographical Information Systems: GIS are very important and evolving fields of study. They are used in a 
variety of researches and now we find their use in Rooftop Rainwater Harvesting too.V.S. Pawar-Patil 
et al. [4], in this paper Google image of study area, global mapper and Arc Gis ver. 9.3software were 
used to identify and calculate the various types of roof areas of houses and buildings located in the 
village. Rande’s coefficient of runoff index for various types of roof and Gould and Nissen formula 
(1999) have been utilized for calculation of potential of roof rain water harvesting. 
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III. TECHNOLOGY 

For the purpose of analyzing RRWH, the software packages Quantum GIS (QGIS) and the software Google 
Earthhas been used. 

A. Quantum GIS 

Quantum GIS is open source GIS desktop software more popularly known as QGIS. QGIS 1.0 was first 
released in January of 2009 although development on the software began back in 2002 by Gray Sheman with the 
first versions of the software intended as a GIS data viewer for Post GIS. QGIS is increasingly becoming a 
viable alternative to commercial GIS desktop software options.QGIS is a volunteer driven project that is 
licensed under the GNU (General Public License).QGIS built using C++, this open source GIS software can be 
downloaded for free, and runs on Linux, UNIX, Mac OSX, and Windows operating systems. QGIS’s has 
smaller file size and less RAM and processing requirements as compared to commercial GIS options. QGIS 
extends its capability through the use of plugins. QGIS also provide access to GRASS’ spatial processing 
modules through a GUI (graphic user interface). Latest at present we used the QGIS version 2.10.1. 

B. Google Earth 

 Google Earth is a virtual globe computer program. Some versions of the software are not freely available 
and the freely available Google Earth can be easily downloaded .It provides high resolution aerial and satellite 
imagery. One can identify and mark places and any other data of interest. Google earth and QGIS allow for 
some inter-compatibility through the use of keyhole Markup Language (KML) and so Google Earth has been to 
get the data for the research KML, a programming language similar to HTML, was specifically designed to 
allow spatial map data to be displayed in virtual earth browsers, such as Google Earth. By supporting KML, 
QGIS allows shape files to be converted foe viewing in Google Earth. Data imported from Google Earth is in 
the KML format and can be converted to shape files of QGIS [7]. 

IV. METHODOLOGY OF PROPOSED WORK 
A. Data Collection 

Complete residential area information can be retrieved through digitization using Google earth. To collect 
the information there are no of different types of data sources, techniques and workflows are involved. Different 
type of filters is used to purify the water and reservoirs are used to collect the pure water. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure2. Collect data 

Fig. 2 shows the area which is taking by using Google earth and in that particular area all buildings such as 
houses, colleges, apartments, malls, shopsis include. The area where the water is harvested from rooftop can be 
easily collect from goggle earth. 
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B. Refinement and Categorization 

 
Figure3. Categorization 

Above information of Fig. 3 can be categorized into individual building   i.e. schools, colleges, apartments, 
offices, malls, shops, houses etc., rainwater from rooftop can be collected from all building and estimate the 
quantity of water and store it in reservoirs. The purified water can be supplied according to demand and the 
quantity of monthly spills from these reservoirs and expenses of RRWH Plants can be calculated. 
C. Calculations& Computations of RRWH 

This paper uses the GIS approach to assess the total area of catchments available for rooftop rainwater 
harvesting and compute the amount of rainfall with a runoff coefficient, then the water which is really harvested 
that can be used to recharge the ground water reservoirs. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure4. Calculations of RRWH 

In Fig. 4, calculations can be done by calculating area of the roof (x, y), amount of rainfall (in m.m.) with 
rooftop coefficient. 
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Figure5. Computations of RRWH 

Fig. 5 shows the computations of RRWH plant where S denote some threshold value, If the collected water is 
more than the threshold value, the RRWH methods should be implement there otherwise discarded directly. 
Expenses can be computed for rooftop rainwater harvesting plants by considering the average rainfall in these 
areas. 

D. Analyze the RRWH 
 
y 
 
 
  
 
x 
 

Figure: 6 Analysation of RRWH 

Cost and Rainfall ratio can be shown by the graph Fig. 6 which shows measuring the expenses on RRWH. 
Steps: 

Step 1:In this Graph x axes denote the rainfall and y axes the cost. 4 points A, B, C, D are taken for analyzing.  

Step 2:At the point A, measuring rainfall amount is in excess and cost is in affordable amount so point A is 
beneficial to implementing the rooftop rainwater harvesting.  

Step 3: On the second point B, measuring rainfalls amount is same as on first point A, but cost on B point is 
minimum as compared to A point so B point is more beneficial as compared to point A for Implementing 
RooftopRain water harvesting plant and on the third point C, measuring rainfall amount is average and cost at 
this point is also average therefore we can think to implement Roof plant on this point. 

Step 4: On the fourth point D, measuring rainfall amount is minimum and cost also minimum at D Point so at 
this point is not beneficial to implement the Roof Harvesting plant and became negligible.At all the above Point 
A,B,C,D, if rainfall became lowest and cost became Higher , then also all these point are negligible for 
implement RRWH plant. 

V. CASE STUDY FOR RRWH 
A. DATA COLLECTION 

3 Areas of 3 different cities of Rajasthan are selected as the site where all the analysis will be done.In these 
areas, there is minimum, average, and Maximum Rainfall, has been chosen for monitoring the effect of 
collecting Rainwater. Some portion of these complete intersection areas is taken into account to calculate the 
area of the roofs with a Roof coefficient and also viewing the effect of placing the container to collecting the 
rainwater. 

A

B

C 

D
Cost 

Rainfall 
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STUDY AREA 

TABLE: 1 SELECTED SITES OF 3 CITIES 

S. No. Area Latitude-
Longitude 

Image 

 
A. 

 
SarojiniMarg, 
Krishna Marg, 
C-scheme area, 
Jaipur, 
Rajasthan. 
 

 
26°54'36.45"N-
75°48'12.73"E. 

 

 
Figure7. Data collection for area 1 

 
B. 

 
B-block, 
Shakti Nagar, 
Kota, 
Rajasthan. 
 

 
25°9'55.63"N-
75°49'36.32"E 

 

 
Figure8. Data collection for area 2 

 
C. 

 
Jai Narayan 
Vyas Colony, 
Bikaner, 
Rajasthan 
 

 
28°0'47.23"N-
73°21'9.73"E 

 

 
Figure9. Data collection for area 3 

In table1, Fig. 7, 8, 9 shows 3 areas of 3 cities which are taken by using goggle earth and in this area all building 
are shown for calculating the roof areas through digitization. It also shows the place mark pointed as different 
names. 

Procedure of Acquiring the Information in steps: 

 Google Earth installation. 
 Start working in it and select the site. 
 Getting data from Google Earth, these images are saved. 
 These images are saved in JPEG files as a Tiff format. 
 As Google Earth > Save Image > Save. 
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B. REFINEMENT &CATAGORIZATION 

Digitization:The one of the most common tasks in GIS is Digitization. Quantum GIS has powerful 
capabilities to digitize Raster Data. High resolution satallite imagery and digitization will be taken to create a 
vector ploygon layer. Once the JPEG file has been stored, import the data in QGIS. 
Procedure for digitizing these areas one by one: 

a) SarojiniMarg, Krishna Marg, C-scheme area, Jaipur 
1. Open the QGIS Tool. 
2. Go to Layer > Add Layer > Add Raster Layer. Locate the download main1.tif and click Open. 
 

 
Figure10. Add Raster Layer 

Fig.10 shows how the Raster and the Vector layer added, selecting the layer option from menu bar. 

3. A Coordinate reference system selector Dialog Box is open and select CRS  WGS 84. Now Raster 
image visible in qgis. 

4. In the main QGIS window use zoom in or zoom out tool to digitizing the data. 
5. Now digitization process is ready to start. We will first select the roofs of different-different buildings 

and digitize the Roof Areas. Go to layer > Create Layer > New Shapefile Layer. You may also choose to 
create a new spatialite layer, instead if you prefer. In this tutorial, we will create different type of 
polygon shapefiles, line shapefiles, and point shapefiles. 

6. Select Polygon as the type. There will have 2 basic attributes - Name and Class. Enter name as the 
nameof the attribute in the new attribute section and click add to attribute list. Similarly create a new 
attribute Class of the type text data. Click ok. 

 
                                  Figure11. Add Shape file Layer                                                    Figure12. Selection of Polygon Layer 

Fig.11 shows how we create and add new shapefile layer to digitize the data and Fig.12 shows how the polygon 
layer will be select. It can be line or point layer also. 

7. Save it as SHP file as roofarea.shp. 
8. Once the layer is loaded, click on the toggle editing button to put the layer in editing mode. Click the 

add feature button. Edit mode is switched on or off individually for each layer. Click on the map canvas 
to add a new polygon vertex. Add new polygon vertices along the roof feature. Once you have digitized 
a roof polygon segment, right click to the end of the feature. 

9. After you right click to end the feature, you will get a pop-up dialog called attributes. Here you can enter 
attributes of the newly created feature. Enter the roof name as it appears on the topo map. Optionally, 
assign a roof class value as well. Click ok. 
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Figure13. Attribute Pop-up boxes for polygon 

Fig.13 shows when the polygons are digitized; a pop-up box of attribute is opened and selects Id, Name as 
Roofname and Class as Roofclass. 

10. Now again click on Add feature to Add new other polygons. You will be able to quickly digitize new 
polygons. 

11. The default color of polygon can be any color, so we can change it by right clicking on the Roofarea 
polygon layer and select the Properties 

12. We can choose color, transparency and click ok. 
13. Now we will see the digitized roofarea polygon feature clearly. Click save layer edits to commit the new 

feature to disk and then click the toggle editing button. 

 
                          Figure14. Digitized Polygon for one building                            Figure15. Complete Digitization of Polygon layer 

In Fig.14 the polygon area for one building is digitizedand Fig.15shows complete digitization of the selected 
buildings of particular area. 

14. No we will create other layer Like Roofboundry layer, RoadLine layer, AreaPoint layer and Mainarea 
layer. Follow same steps for digitizing as upper layer: 
 Go to layer > Create Layer > New Shapefile Layer. 
 Select Point/Line/Polygon any as a type. 
 Enter name as name attribute and class as another attribute.Click ok. 
 Save all layers in .shp files. 
 Click the toggle editing button to put the layer in editing mode. 
 Click the add feature button. 
 After digitizing all segments, right Click on the end of the feature. A pop-up dialog box(attribute), 

give name and click ok. 
 Click Save Layer Edits.Click the Toggle Editing button. 
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Figure16.Complete digitization of all Layers 

Fig.16 shows the digitization of 6 buildings. Building can be any like school, hotel, hospital, and any House. 
Four measure points are digitized to calculate the total area in which the all building are come to use to calculate 
area for collecting the rainwater, is also digitized. 

15. Now convert this Raster layer into Vector layer by importing the shapefiles of all layers. 

 
Figure17. Vector Image 

Fig.17 shows the vector layer with a clear view of digitized selected roof buildings, roofboundaries, roadlines, 
Area points, Main area. 

b) B-block, Shakti nagar, Kota 

For digitizing this area the same steps are followed as above and after followed these all steps we digitized 
the shaktinagar, kota area and then convert this Raster layer into Vector layer by importing the shapefiles of all 
layers. 

 
                         Figure18. Complete Digitization of Area2                                                     Figure19. Vector layer for Area 2 

Fig.18-19 shows the digitized area of Shakti nagar, Kota. In this 5 buildings are digitized and also digitized the 
Areapoints, Roadlines, Roffboundries, and Mainarea and show the vector layer with a clear view of all layers. 

c) Jai Narayan Vyas Colony, Bikaner 

Same as area B the area C- Jai Narayan vyas colony of Bikaner is digitized and converted it into Vector 
layer. 
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                         Figure20.Complete Digitization of Area 3                                                Figure21. Vector layer for area 3 

Fig.20-21 shows the digitized area of Jai Narayan Vyas, colony, Bikaner. In this 5 buildings are digitized and in 
vector layer a clear view of digitization is showing. 

C. CALCULATION & COMPUTATION OF RRWH 
1) Calculate area of Roofs: 
The roof areas of each and every building have been calculated in QGIS. Here the calculation of all selected 

areas one by one: 
a) SarojiniMarg, Krishna Marg, C-scheme area, Jaipur 
i. In QGIS tool, make the layer editable. 

ii. Use the field calculator as 
 Layer > open attribute table > field calculator/ctrl+i. 
 OR right click shapefile> open attribute table > field calculator. 

 
Figure22. Layer Attribute Table 

Fig.22 shows the attribute table of Polygon layer in which the columns of name and class is defined as attribute. 

iii. Open field calculator > select the new column and type the following expression: 
 Field name: area  
 Field type: decimal  
 Output field width:10  
 Precision: 4  
 In function > Geometry > Select $area for find area of any polygon and $length for find length of 

any line. 
 When you click ok, you will have a new area field added to your table. The area is in square units. 

It will typically be square feet or square meters dependent on your projection. 

iv. Again Open Attribute Table and see the calculated area of each and every RoofPolygon in meter 
square (m2). 
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                         Figure23. Areas through Field Calculator                                                   Figure24. Calculated Area of Area 1 

Fig.23 shows the procedure for selecting the field calculator and calculate the area and length by selecting the 
$area and $length as function of the all Roofs and Fig.24 shows the all calculated area of all the polygons by 
making a new column in attribute table.  

v. Calculate the X and Y coordinates of areapoints: 
 Vector > geometry tools > export/add geometry columns. 
 A pop-up box will open > select input vector layer. 
 Click ok, layer areapoint updated. 

 
Figure25. X and Y coordinate through Geometry Tools 

Fig.25 shows finding the X and Y coordinates for point area using geometry tools. 

vi. The length of any Line also Calculated by using these all steps and function as $length. 

For calculating the Roofarea of each building same steps are followed as for SarojiniMarg, KrishaMarg, C-
scheme area, Jaipur. The calculated area is also in m2, as follows: 

b) B-block, Shakti nagar, Kota                                    c) Jai Narayan Vyas Colony, Bikaner 

 
                             Figure26. Calculated Area of Area 2                                                      Figure27. Calculated Area of Area 3 

Fig.26-27 shows the all calculated area of all the polygons by making a new column in attribute table. 
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2) Rainfall data collection 

There is different rainfall of each and every place in different states. This average annual rainfall has been 
considered for carrying out assessment of Water Collection.The average annual rainfall of these 3 selected areas 
is shown in table2. 

TABLE: 2 ANNUAL AVERAGE RAINFALL OF SELECTED AREA 

Area SarojiniMarg, 
Krishna Marg, C-

scheme area, Jaipur 

B-block, Shakti 
nagar, Kota 

Jai Narayan Vyas 
Colony, Bikaner 

Average 
Rainfall(mm) 

640 880 350 

3) Coefficient of rooftop 

Coefficient of rooftop (Cr) for any catchment is defined as “The ratios between volumes of water that runs of 
and that of total volume of rain that fall on the Rooftop”. The Runoff coefficient of different structure is given in 
table 1. 

TABLE: 3 ROOFTOP COEFFICIENTS FOR ROOF 

S. no. Type of Rooftop Rooftop coefficient 

1. Galvanized sheets 0.90 

2. Asbestos 0.80 

3. Tiled 0.75 

4. Concrete 0.70 

Table.3shows different type of coefficients which are depends on the type of roof. These areas are assumed as 
RCC Roof (Concrete), so the Runoff coefficient of 0.70 has taken. 

4) Assessment of collection of rainwater 

For assessment of collection of rainwater there is 3 Parameters will come to use in calculating the rainwater 
i.e. total roofarea, average rainfall,  runoff coefficient. 

Calculations will be done by using this formula: 

Water Available 
From Roof (W) 

= Total Roof 
area (T) 

× Average 
Rainfall (A) 

× Runoff Coefficient 
(R) 

 

 

 

(Unit = Liters) 

5)  Tank capacity 

Capacity of tanks is estimated according to the collected water from Rooftops. The diameter and the height 
of the tank are proposed according to the collected water and beyond the collected water. The tank is also placed 
according to the area. Tank can be underground or can be on ground level also.  

6) Calculated tables 

Calculations of water collection for each Roof in Given 3 Main areas are shown in table 4, table 5, and table 6. 

TABLE: 4 CALCULATED AREA & AMOUNT OF WATER OF SAROJINI MARG, JAIPUR 

S. No. Roof Name Calculated 
Area (m2) 

Water Available from 
Roofs (Liters) 

(W=T×640×0.70) 

Tank Capacity 
(in liters) 

1. Park Prime Hotel 2027.23 908199.04 950000 

2. Hostel 714.75 320208 375000 

3. Collage 1923.64 861790.72 900000 

4. 91 Mall 513.38 229994.24 275000 

5. House 598.5 268128 300000 

6. Hospital 794.42 355900.16 400000 
 
 

W = T × A × R
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TABLE: 4 CALCULATED AREA & AMOUNT OF WATER OF SHAKTI NAGAR, KOTA 

S. No. Roof Name Calculated 
Area (m2) 

Water Available from Roofs 
(Liters) (W=T×880×0.70) 

Tank Capacity 
(in liters) 

1. CarrierPoint 2433.81 1499226.96 1550000 

2. Hostel 1701.12 1047889.92 1100000 

3. Hotel 2163.54 1332740.64 1480000 

4. House1 1103.68 679866.88 735000 

5. House2 2379.36 1465685.76 1515000 

TABLE: 4 CALCULATED AREA & AMOUNT OF WATER OF JAI NARAYAN VYAS COLONY, BIKANER 

S. No. Roof Name Calculated 
Area (in m2) 

Water Available from Roofs 
(in Liters) (W=T×350×0.70) 

Tank Capacity 
(in Liters) 

1. RSV school 10557.76 2586465 2645000 

2. Hostel 2974.75 728813.75 775000 

3. House1 1265.87 310138.15 380000 

4. House2 1017.64 249321.8 300000 

5. House3 1941.16 475584.2 530000 

Table.4, 5 & 6 shows the total Roof area of this selected area which is in meter square, calculation of water 
available from roofs in liters, capacity of tanks according to water availability. 

VI. RESULT& DISCUSSIONS 

It was challenging job to convince the community for utilization of Rooftop Rain Water Harvesting for 
drinking purpose with few management tips.  

TABLE: 7 PARAMETERS AND AREA OF 3 CITIES 

Area 
Parameters 

 
Jaipur 

 
Kota 

 
Bikaner 

Area (km2): 11,117 5,217 27,244 

Population: 30,73,350 19,51,014 23,63,937 

No. of Household: 11,77,096 3,96,501 3,84,944 

Table.7 shows 3 different area and different parameters as calculated area, population, no. of households.These 
three areas are spread over different kilometers with different population and different no. of households. In 
developing countries particularly in rural areas, it is assumed that 20 liters of water/capita/day is required to 
fulfill the basic domestic need including hygiene and health (UNO, 1990). Considering this UNO’s minimum 
threshold of domestic water use, then in these cities the cumulative annual demand of water for total population 
of these cities would be calculated.Gould and Nissan formula (1999) have been utilized for calculation of 
potential of RRWH.The fruitful statistics of roof area exhibits that most of the roofs have been comprised by 
backed tiles, cement concrete and tin sheets respectively. The water collection efficiency varies with roof type, 
though cement concrete roof is having maximum collection efficiency. 

In this paper some area of these 3 cities has been selected for calculating the area of building rooftops. The 
rooftop coefficient and the average annual rainfall of these three cities are used for the calculation.It is assumed 
that the roof type of these cities is of cement concrete. So the amount of water collected inthese 3 cities has been 
calculated. 
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TABLE: 8 COMPARATIVE ANALYSES OF 3 CITIES ACCORDING TO AREA& AMOUNT OF WATER 

S. 
No. 

Area(m2) 
(range between 

0-3000) 

Water available from Roofs (in Liters) 

Jaipur (with average 
rainfall 640 mm) 

Kota (with average 
rainfall 880 mm) 

Bikaner (with average 
rainfall 350 mm) 

1. 0-500 225994 > 300000 < 125000 

2. 500-1000 355900 579884 242321 

3. 1000-1500 595624 845624 310138 

4. 1500-2000 764790 1047889 415584 

5. 2000-2500 1081990 1352640 563198 

6. 2500-3000 1308224 1699226 708813 

7. >3000 >1500000 >1800000 >1000000 

Table.8 shows a comparative analysis of 3 cities for collecting rainwater,takingareas within the same 
range.From this table it can be concluded thatamong these 3 cities,Kota will be thebest for collecting rainwater 
in every range as it has the highest rainfall. In range of 1500-2000 m2 area the collected water inKota and that of 
Bikaner in range >3000 m2 is almost equal. The difference lies only in the area selected that means the area 
where the average rainfall is low, the RRWH plants or methods must be implemented on wider areas such as 
schools, Apartments, hospitals and areas where the average rainfall is high, RRWH methods/plant should be 
implemented whether the area is wide or smallwhereat least the water requirement ofthe population of that 
particular area is fulfilled. If more than the required amount of water is collected, the extra amount can be used 
by others in need. 

VII. CONCLUSION 

India receives the highest rainfall among countries comparable to its size. The best way to conserve water is its 
judicious use. One-eighth of India is declared as draught prone, there are several thousand villages in India 
which do not have potable drinking water. In this case study, it seems an urgent need to implement ideas that 
will help in preserving water. Various RRWH methods can be implemented here. In this paper different areas of 
3 cities have been selected for analyzing and proper digitization.To achieve the goal of this work, Google Earth 
and QGIS tool were used to select the site, estimate the area of roofs and volumes of water that can be harvested 
from building rooftops within each city.Reservoirs can be built according to amount of water collected. The 
basin should be treated as one unit for planning water utilization.Amount of rainfall can prove to be of great 
importance, as areas where rainfall is less RWH methods are of no use and areas where amount of rainfall is 
quiet good RWH methods should be done mandatory.Estimation of the quantity of monthly spill from these 
reservoirs and estimation of expense that will be involved can be calculated which will further help in future for 
making a decision support system or as a source of knowledge to be provided to people so that they can gain 
some idea on how water can be saved. 
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